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Menus 
Many commands and menus are common to all applications within CS ChemFinder. These include the majority of 
commands in the File and Edit menus as well as the Scripts and Windows menus. The names of the common 
commands will differ in the name of the application appended to the command. Information about the Scripts 
menu and customized menus (for example, the Net, Database and Import menus in CS Table Editor) are discussed m 
the "Scripts Menu and Customized Menus" section. The other common menus and commands are described only 
once in "CS Table Editor" section. However, they are highlighted in purple. Application specific menus are discussed 
in that application's section 
NOTE: The Windows me,,,,, o 即 of the co111111011111en11s, is 110/ show11, /11 su11111iary, all open windows appear i11 this menu. Thefro11/mosl wi11dow 
has a c/1eck111ark arljace 叫 to 溈 11a111e. Selecting a c0111111a11d from this me>lli brings that wi11dow Jro11t111ost 

CS Table Editor 
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Stationery 
Open … I 

Creates a new document with pceconhguced 
卜— infonnation depending on the Stationecy pad you 

!€0 choose from the submenu 

Close Window 
Saue 
Saue As. 

Finds the next matching cecocd containing the 
information you specified in the Find dialog box 

Fine! ... 
Fine! Again 
Fine! Selection 

呻「 Closes the frontmost window. Prompts you to save 
酗

changes if you have not done so 
一 Displays the Save dialog box where you can 

specify a new name, location oc file fonnat to save 
a copy of the frontmosl window 

紅 — Di 、plays a dialog box whece you can specify 
邸 I information to find in the frontmost table 
睏 — Finds infocmation in the frontmost table that 

matches mformation in the selection 
Presents a dialog box where you specify page 
setup values for printing the frontmost table, such 
as the page size, orientation and scaling 

Liu«" 、the ,,ctiv,• ,,pplicdt,on. Prompt, you to s,1ve 
,h,,,,g,· 丶tn am open d,wunwnt 、if vnu have not 
dnnc,o 

Page Setup .. 
Print Window ... 唧 l Drsplays a dialog box where you can specify 

printing options, such as number of copies of the 
frontmost table to print 

Quit CS Table Editor !1:0 
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Sorts ,nformation ,n the frontmost table based 
on the field name you choose. To sort in 
descending order, hold down the Option key and 
select a field name 

Displays a dialog box where you can create, 
modify or delete fields stored in the fable Editor 
Terminology file 
Displays a dialog box where you can specify 
whether fields are calculated when hidden in a 
closed ,-ecord, You can also specify the font and 
font s,ze used to d,splay information in all tables 

Displays a dialog box where you can select fields to 
insert ,n the frontmost table 
D,splays a submenu where you can specify 
whether field names are shown beside the cell ma 
record or only in the column heading 
When a single field name is selected, displays a 
dialog box where you can create, modify or delete 
a script attached to the selected field name 

Removes the selection from the active window to 
the Opboacd 
Pastes mfonnation to the location of the mse,tion point 囯
the location ,s compat,ble with the type of information) 
Selects all information in a selected text box. In a 
table, Select All will select all infocmation within a 
table, o, all field names in a column heading 

Adds a new record to the end of the 
frontmost table 

by Name Only field names In the frontmost 
by ID table appeac In this menu. Strnctu,e 
by Notebook Number and model field names arc not 
by Formula so,table, and the,efo,e don't appeac 
by Molecular 山eight In the menu 
by Comments 

Align 
Show Field Names~ 
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Script ... 

Classify Records .. 

Displays a dialog box where you can create, 
modify or delete classes stored In the Table Eddor 
Terminology file 

When one o, mo,e field names a,e selected, 
displays a submenu whe,e you select how to ahgn 
them ,elative to one anothe, 
When a single field name is selected, displays a 
dialog whe,e you can assign an alternate name 
to a field for use in that table 
Displays a dialog whe,e you can select the class of 
,eco,ds sto,ed in the frontmost table 



ChemFinder Database Manager 

Updates the index for the open database. If an 
index has not been created, the Set Source Folder 
dialog box appeacs 

Displays a dialog box where you can select the 
folder that contains the tables you want to index 
in the database. All tables must be within a 
single folder 

SD File Translation 

Displays a dialog where you cao select a file ,n 
SD or MDL MolFile format for importing 

Set Source Folder 
Set Table StationerJJ_ ... 

Displays a dialog box showing the numbe1 and 
class of 1ec01ds indexed in the frontmost database 

Displays a dialog where you can select a Table Eddor 
Stationery pad with which to create a table for 
showing search cesults 

!€1 
Displays a dialog box where you can map the fields 

D,splays a dialog where you can select a Tal,/c Eddor Define SD Fields... --t- ,nan SD file to those in CS Tal,/e Edda, 
Stationery pad with which to create a table for -+ Set Table Stationery …
showing imported data 

ChemDraw File Translation 

Displays a dialog wlme you can select a file m 
Clte111Dmw format for importing 

CS Crossfire Client 

Displays a dialog box where you can — select a Table Edito, Stationery pad with 
which to create a table for showing 
imported data 

Connects you to the Crossfoe'" server and database 
spwftcd for the open connecbon. If none are 
specified you are presented with the Connection 
Settings and Login settings dialogs to fill in 
Displays a dialog box where can specify settings for 
communicating with the CrnssFirc server application 
and specify the Beilstein"'database to search 

Displays a dialog box where you can select a 
To/,/c Edita,·Statione,y pad 、vith which to create a 
table fo, showing search results 

CS UNITY Client 
Connects you to the server where UNITY1'" resides 
and opens the UNITY database specified for the 
open connection. If no databases are specified you 
are presented with the Connection Settings and 
Login settings dialog boxes to fill In 

Displays a dialog where you can specify setfo1gs 
that allow you to establish communication with the 
server where UNITY resides 

Displays a dfalog whece you can specffy the type of 
connechon and scthngs foe communfcahng with 
the CcossFfce secvec (foe example, secfal, modem, 
oc TCP/IP) 
Displays a dfalog box whecc you can choose a 
Beflstefn database that Crnssfoe wfll seacch that 1s 
othec than the one specfffed fn the Logfn settings 
dfalog box 

Displays a dialo~whece you can specify the type of 
connection and settings for communicating with 
the se,ve, (focexample, secial, modem, oc TCP /IP) 

Displays a dialog box where you can choose a 
UNITY database othe, than the one specified m the 
Login settings dialog box 

Scripts Menu and Customized Menus 

The Snipts menu in each CS Cl,emFn,dc, application is a customizable menu that can contain compiled snipts, documents o, othe, 
appl,cations. The Scnpts menu foe each application and the items it contains conesponds to the contents of that application's Scripts 
folde,, located in the same folde, as the application. Fo, instance, in CS Table Ed do,, the Snipts folde, is named "Tahle Eddo, Snipts 
Dragg,ng the icon of the snipt, document o, 唧 l,cation into the folde, adds the ,tem to the Snipts menu 

In addition, any folde, added to a Snipts folde, appeacs as a menu in that appl,cation's menu bac. Items within the folde, become that 
menus commands. Several additional menus m CS Table E 巾to,, such as the Net, Im poet and Database menus, wecc mated this way 

Items in the Snipts folde, and additional custonnzed menus that come with CS C/,cmFn,dc, ace desnibed in the document" About 
"l'/'1,catum Snipts" in that apphcation's Snipts menu 



Quick Start 
The following are a series of instructions to give you a quick start to using CS ChemFinder's applications. A more 
in-depth and graphical tutorial, where tasks are executed from within the CS Table Editor, can be found in 
"Getting Started" within the CS ChemF,nder User's Guide 

Entering Information 
1. Double-click the CS Table Editor application icon 
2. Create a new table preconfigured with fields and scripts by choosing New Compound Table from the Stationery 

submenu in the 囧e menu 
3. Classify the contents of the table by choosing Classify Records from the Setup menu and select "Compounds" ,n 

the dialog box that appears. Click the OK button to complete the command 
4. Add a new record to the table by choosing New Compound from the Edit menu 
5. Enter your first compound by first typing a name in the Name cell, for examp 區 "lsopropyl benzoate" as shown ,n 

the Example Table to the right 
6. Open the record and display additiona 丨cells by clicking the expansion triangle to the 岫of the Name cell 
7. Open CS ChemDraw for drawing a structure by double-clicking the hyphen in the Structure cell 
8. Draw the structure in the ChemDraw document window that appears, then click the Close box. Click the Save 

button in the message window that appears 
NOTE. Because of scripts affached ta lield, in 加 particular table, the appearance of your structure ,s quickly followed by the 
appearance of a molecular model, formula, and molecular we 的

Importing Information 
If you have ChemDrow files or files in MDL Mo/File or SD File format you can import them using the ChemDraw and 
SD File Translation applications. This set of instructions assumes you have a file in one of these formats. If not, use one 
of the files in the ChemFinder Tutorial folder installed with CS ChemFinder 
1. Double-click the SD 囧e Translation or ChemDraw File Translation application ,con 
2. Choose Import SD File or Import ChemDraw File from the Data menu 
3. Locate and select the file that you want to translate from the directory listing in the dialog that appears. C 朊k the 

OK button 
4. The translation proceeds and the number of compounds appears in the counter in the translation window 
5. Click the Show button at the bottom of the window to display the translated compounds in a CS Table Editor table 

NOTE If you are importing SD Files, you w,/1 probably want to map the fields so they correspond to CS Table Editor lields See 
Chapter 8, File Translations in the CS ChemFinder User's Guide to learn how to mop fields 

Creating a Database 
1. Put all the tables that you want in a database within a single folder 
2. Double-click the Chemfinder Database Manager icon 
3. Choose New Database from the 這 menu 
4. Choose Update Indexes from the Database menu 
S. When the Set Source Folder dialog appears, locate and open the folder containing the tables that you want to 

index 1n the database, then click the "Select folder" button at the bottom of the dialog 
NOTE You will not see the tables ,n the folder, you w,11 only see the empty folder you have opened 

6. After indexing is complete, choose Save from the File menu and specify a name and location in which to save the 
database (a good place is in the same folder as its tables), then click the OK button 
NOTE·The database saves the ,ndex and queries, but not results from a later search 

Searching a Chemfinder Database Manager Database or a Beilstein Crossfire™ Database 
1. Open the database or connection (CS Crossfire Client} 
2. If you are searching a Beilstein database, first establish a connection to the Crossfire server from with 

CS Crossfire Client 
3. Click the New Query button 
4. Specify the query by making selections in the right side of the window 

NOTE ii you save the database or connection the queries are saved, but the search results are not 
5. Click the Find button 
6. When the search ts complete, click the Show button at the bottom of the window to display the results tn a 

CS Table Editor table 

Moving Information in a Table 
1. Open the table whose 祉ormation you want to move 
2. Select or Shift+click the cells, records or field names you want to move 
3. To duplicate items in a new table, drag the selection outstde the boundary of the window 
4. To remove items from o table and place them in a new table, hold down the Option key as you drag the selection 
S. To duplicate fields without their data (a shortcut for inserting fields), hold down the Option key and drag only the 

field names outside the boundary of the table 
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